## CONTENTS

1 Introduction ........................................................................................................ 1
   1.1 Data Modes ................................................................................................... 1

2 Installation ........................................................................................................... 3
   2.1 System Hardware ............................................................................................ 3
   2.2 Installing the Hardware .................................................................................. 4
      2.2.1 Installing the Spectral Imager ................................................................. 4
      2.2.2 Installing the GPS/IMU ......................................................................... 5
      2.2.3 Magnetometer Calibration ...................................................................... 12
      2.2.4 Considerations if using system on gimbal ............................................. 12
      2.2.5 Initializing the GPS/IMU ....................................................................... 12
      2.2.6 Installing the Flight Computer ............................................................... 12
      2.2.7 Installing the Downwelling Irradiance Sensor ...................................... 13
      2.2.8 Connecting Power .................................................................................. 13
   2.3 Installing and Connecting the Ground Station Software ............................... 13
   2.4 Data Disk File System ................................................................................... 13
      2.4.1 Legacy System Data Disk ....................................................................... 13

3 Using the Airborne Spectral Imaging System ...................................................... 15
   3.1 Powering Up the Flight Computer ................................................................. 15
   3.2 Launching the Software and Connecting to the Flight Computer ............... 16
   3.3 Status Panel .................................................................................................. 18
   3.4 Flight Tab ...................................................................................................... 20
   3.5 Imager Tab .................................................................................................... 22
      3.5.1 Radiometric Calibration ......................................................................... 23
      3.5.2 Auto Expose Settings ............................................................................ 25
   3.6 GPS/IMU Tab ................................................................................................ 27
      3.6.1 Ellipse GPS/IMU Status Detail .............................................................. 28
      3.6.2 Ellipse GPS/IMU Magnetic Calibration ................................................ 29
   3.7 Computer Tab ............................................................................................... 31
   3.8 Storage Tab ................................................................................................... 32
   3.9 Targets Tab .................................................................................................... 33
   3.10 Command Line ............................................................................................. 35
   3.11 Menu Items .................................................................................................. 35
      3.11.1 File ......................................................................................................... 35
      3.11.2 Preferences ........................................................................................... 36
      3.11.3 Comms .................................................................................................. 36
   3.12 Transferring Data ......................................................................................... 37
   3.13 Post Processing Data with Spectronon ......................................................... 37
   3.14 Using the GeoRectify Spectronon Plugin .................................................... 40
3.14.1 Biases ................................................................. 42
3.15 Using the Mosaic Tool ............................................ 42

4 Operation Summary and Checklist ................................ 43
  4.1 Mission Setup .......................................................... 43
  4.2 Pre Flight ............................................................... 43
  4.3 Flight (All operations are optional) ............................... 43
  4.4 Post Flight ............................................................. 44
  4.5 Data Files and Structure ........................................... 44
  4.6 Keys to Obtaining Quality Data ................................ 44
  4.7 Recalibration Services ............................................. 45

5 Advanced Operation .................................................. 46
  5.1 Sending Special Commands to the Flight Computer ............... 46
  5.2 Updating Firmware ................................................... 46
  5.3 Pairing a GPS/IMU with a Flight Computer ....................... 49
  5.4 Pairing/Unpairing a Downwelling Irradiance Sensor with a Flight Computer .................................................. 49
  5.5 Reformatting Disks ................................................... 49
  5.6 Changing Default Cube Length ................................... 49
  5.7 Troubleshooting ...................................................... 49
    5.7.1 System Checks .................................................. 49
    5.7.2 Data problems ................................................ 50
    5.7.3 Flight Computer Logs ........................................ 50
INTRODUCTION

The Resonon Airborne Spectral Imaging System is a compact, high fidelity, digital imaging spectrometer for airborne applications. The system consists of a Pika imaging spectrometer, a flight computer, a GPS/IMU, an optional downwelling irradiance sensor, an optional external USB LCD display, Spectronon data analysis software, and the ResononGroundStation software.

This user manual covers the installation and use of the hardware and software. Topics covered in this manual include:

- Installing the spectral imaging hardware
- Installing and configuring the ResononGroundStation software
- Configuring the Airborne Spectral Imaging System
- Flight operations, data download, georectification

1.1 Data Modes

Airborne hyperspectral data from the Resonon imaging system can be utilized in three forms, as summarized below.

**Raw data:**
This data is spectrally calibrated but contains the instrument response and illumination functions. This is the least useful form, as the spectral curves do not have real units or real physical meaning.

**Radiance:**
The flight computer can acquire raw data for later processing or it can process the data to radiance as it is collected. The mode of collection can be selected in the Imager Tab. If radiance mode is selected, the appropriate calibration file must be uploaded to the flight computer. This file is also necessary for post processing to radiance using the radiance conversion plugin in Spectronon.

The radiance data form does not include the instrument response function. Additionally, it has the advantage of possessing real units and physical meaning.

**Reflectance:**
In reflectance mode, both the instrument and illumination functions are removed. This leaves the data in absolute reflectance. Data can be converted to reflectance with one of four ways:

- **White reference that spans the FOV:**
  Data can be processed to reflectance with a calibration against a reflection standard that spans the entire FOV of the instrument. This is often impractical for airborne systems, but does have the advantage of not requiring processing to radiance. The highest quality reflection standard is Spectralon, but teflon is acceptable for many applications.
Note: Teflon needs to be sanded with 100 grit sandpaper on an orbital sander to eliminate any specular properties.

This calibration is done with the Record Correction Cube feature, as described later in this document. It is important to note that reflectivity values are only accurate if the solar illumination (clouds, sun angle, etc) does not change between the collection of the correction cube and the collection of data cubes. Data can be converted to reflectance using Spectronon’s Reflectance from Raw Data and Spectrally Flat Reference Cube plugin.

- **Known spectral reference in scene:**
  The spectrum of a reference object in the scene can be used to correct the data to reflectivity. The reference spectrum must be known and in a tab or space delimited file, then use the Reflectance from Radiance Data and Measured Reference Spectrum plugin in Spectronon to convert the data. The data also must first be converted to units of radiance in order to correct for spatial variation of the instrument. This method can be the most accurate but is also not practical for some applications.

- **Downwelling Irradiance sensor:**
  The most convenient method for converting data to reflectance is to use a downwelling irradiance sensor. This sensor records the solar spectral irradiance during flight. This data is used, along with radiometric calibration files supplied by Resonon for both the spectral imager and downwelling sensor, in the Reflectance From Raw Data and Downwelling Irradiance Spectrum plugin for Spectronon. If data is converted to radiance onboard the flight computer, it can later be converted to reflectivity with the Reflectance from Radiance Data and Downwelling Irradiance Spectrum plugin.

- **Atmospheric Correction:**
  Data can be converted to reflectance data with the use of atmospheric correction algorithms such as FLAASH (Fast Line of Sight Atmospheric Analysis of Spectral Hypercubes). Please contact Resonon for more information.
2.1 System Hardware

The Resonon Airborne Spectral Imaging system includes:
- Pika imaging spectrometer. This may be:
  - Pika L VNIR USB3 spectrometer
  - Pika XC2 VNIR USB3 spectrometer
  - Pika IR GigE spectrometer
- Resonon flight computer
- USB-C SSD hard disk
- GPS/IMU
- Downwelling irradiance sensor (optional)

Resonon provides the **ResononGroundStation** software to connect to and configure the flight computer. This requires a computer with:
- Windows
- 512MB of RAM
- Serial Port or USB->Serial Adapter
- Null modem serial cable or adapter
2.2 Installing the Hardware

The spectral imaging hardware should be mounted in the airframe with the following considerations:

2.2.1 Installing the Spectral Imager

- The Pika should be sighted straight down through the airframe. The Resonon logo on the instrument should face either left or right relative to the direction of flight. The Pika should be square with respect to the GPS/IMU system (there should be zero angle in pitch, roll, and yaw between the two) as well as to the axis of the aircraft.

- The Pika should be mounted in a manner to reduce high frequency vibrations, but rigidly to low frequency vibrations with respect to the GPS/IMU.

- Do not attempt to adjust aperture (F#) of the Pika or the radiometric calibration will be void.
Connecting the Pika L and Pika XC2 USB3 imagers

- Pika L and Pika XC2 USB3 imagers connect to any USB3 port on the flight computer.

Connecting the Pika IR imager

- Connect the Pika IR Ethernet port to the Ethernet port on the flight computer.

2.2.2 Installing the GPS/IMU

- The Ellipse, by default, should be mounted with the labeled Z arrow pointed nadir and the X arrow pointed in the direction of flight. If this is not its mounted orientation, it can be reconfigured in the sbgCenter software. In the case of a complete package such as the gimbal caddy or VIP, the Ellipse orientation has already been configured.

- The edges of the unit should be as parallel as possible with the airframe. Small angular misalignment can be entered into the Alignment & Lever Arms section of the SBG software, as discussed below. There are alignment holes in the base of the Ellipse that can be used to align the unit to reference pins. See the Ellipse user manual for the location of these holes.

- The unit should be vibration isolated, if possible, but in the same inertial frame as the Pika. The GPS antenna should be screwed into the appropriate SMA terminal, and the antenna itself should be mounted with a clear view of the sky. Use brass screws to mount the unit. The unit should be positioned as far away from any potential source of magnetic interference as possible.

- If using a dual antenna system, both the Primary Lever Arm (distance from IMU to Antenna 1) and the Secondary Lever Arm (distance from IMU to Antenna 2) must be entered. See section below on dual antenna systems.

- GPS reception is sensitive to electromagnetic interference (EMI). The GPS antenna should be placed as far as possible away from radios, other GPS antennas, the flight computer, spark plugs, or any other potential source of EMI. Try to avoid running the GPS antenna parallel to other wires or cables for much distance. Do not bend the GPS cable excessively. A ground plane under the antenna helps significantly. Connect the GPS antenna to the GPS/IMU unit.

- For the Ellipse D, the further the antennas are positioned from each other, the better the heading accuracy. See the chart below:

<table>
<thead>
<tr>
<th>Separation (m)</th>
<th>RMS Error (deg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>0.15</td>
</tr>
<tr>
<td>1.0</td>
<td>0.3</td>
</tr>
<tr>
<td>0.5</td>
<td>0.6</td>
</tr>
<tr>
<td>0.25</td>
<td>1.5</td>
</tr>
</tbody>
</table>

- Configure the Ellipse with the proper lever arm adjustments following the instructions in the next section.

- Connect the Ellipse USB cable to any of the USB ports of the flight computer.
Configuring the Ellipse N/D

- Connect the Ellipse to a Windows computer with sbgCenter installed.
- Launch the software and press the Connect/Disconnect button. Press Refresh and connect to the attached device.
- Press the Configure button.
- In the Sensor page and Motion Profile tab, select Multi-Rotor, Helicopter or Airplane depending on your vehicle.

In Alignment and Lever Arms, configure the orientation of the SBG to match how it is mounted in the airframe. For example, if the X Axis label on the unit points to the right wing of the aircraft, select X Axis = Right. As a reminder, the ‘cross’ icon of the Z axis label on top of the unit shows the tail end of an arrow. This icon shows the Z axis pointing down through the unit.
• Now enter the distances (X, Y, and Z) between the SBG unit and the lens of the Pika spectral imager. These distances are measured from the SBG unit to the Pika lens, with positive X pointing forward, positive Y pointing right, and positive Z pointing down.

**Note:** Lever arm distances are entered in vehicle coordinates, meaning that X is forward, Y is right and Z is down regardless of how the the SBG unit is oriented.

• In the *Aiding* page and *Gnss1* tab, enter in the lever arm between the SBG device and center of GPS antenna. Again, positive X is pointing forward, positive Y is pointing right, and positive Z is pointing down. If using a dual antenna system, the *Primary Lever Arm* distance is form the IMU to antenna 1, while the *Secondary Lever Arm* is from the IMU to antenna 2. Both measurements are in aircraft coordinates.

**Note:** Lever arm distances are entered in vehicle coordinates, meaning that X is forward, Y is right and Z is down regardless of how the the SBG unit is oriented. These distances need to be measured to within 5 cm.
• If the primary arm distance is measured to within a centimeter (highly recommended), select the checkbox stating as such.

• In the Magnetometer tab of the Aiding section, set the Aiding rejection to Automatic if using the Ellipse N or to Never Accept if using the Ellipse D (dual antenna).
• If using the Ellipse N, the magnetometer must be calibrated before use. See the section below.

• In the **Input/Output** page **Interfaces** tab, set the **Port A Baudrate** to 460800.

**Warning:** If the **Port A Baudrate** is set to any value other than 921600, 460800 (preferred) or 115200, the flight computer will not communicate with the SBG unit.
• Do not change any other settings or the flight computer may not be able to communicate with the device or the output data might be erroneous.

• Save settings and exit.

• For more information, please read the Ellipse Configuration using sbgCenter user manual.

Note: If using the sbgCenter software to monitor GPS reception, you must set the Port A log settings to their default levels, as shown below. They do not need to be set back before connecting to the airborne system.
2.2. Installing the Hardware
2.2.3 Magnetometer Calibration

If you are not using a dual antenna system, the magnetometer must be calibrated before data collection as well. This can be performed on the ground, or preferably, in the air. This procedure can be performed with the sbgCenter, or if in the air, with the ResononGroundStation software. It has been Resonon’s experience that a 2D calibration is difficult to perform in the air due to the need to keep the wings level. A 3D calibration is preferable for accuracy reasons and should be performed if possible. Please see the Magnetic Calibration section of Ellipse Operating Handbook - Use in Airborne Applications (in the Ellipse Documentation) document for instructions on performing these calibrations.

If using the ResononGroundStation software, please see the Ellipse GPS/IMU Magnetic Calibration section in the Operation chapter of this manual.

If using the sbgCenter software, please see the Magnetic Calibration section of Ellipse Operating Handbook - Use in Airborne Applications (in the Ellipse Documentation) document for instructions.

If performing a 2D magnetic calibration, enter the Initial Position & Date in the Sensor setup tab. For UAV use, the system can be spun on a flat, non-ferrous table to assist in the 2D calibration.

**Warning:** Do not change any of the Input/Output or Data Output settings while using the sbgCenter.

2.2.4 Considerations if using system on gimbal

- The yaw axis of the gimbal should be locked to the rotation of the aircraft and not allowed to rotate independently.
- The system should be in its operating position (spectral imager pointing nadir) at power up for the system to properly align.
- If the gimbal changes its attitude too drastically, the GPS/IMU may decide to ignore GPS location. In the Aiding section of the sbgCenter software, set the Position Aiding Rejection to Always Accept to prevent this.

2.2.5 Initializing the GPS/IMU

- The system should be in its operating position (GPS/IMU in configured flight orientation) and have a clear view of the sky at power up. For dual antenna systems, minimize any opportunity for GPS signal reflections off of buildings or other objects.
- The Ellipse N should be flown at a velocity of at least 15 km/h (10 mph) before collecting data, which can happen at slower speeds.
- Flying in some patterns (left and right turns, accelerations, etc) before collecting data helps with the attitude accuracy.

2.2.6 Installing the Flight Computer

- The flight computer needs airflow- do not completely enclose the unit or block airflow around it.
- Keep power cables to the flight computer as short as possible. The unit draws a substantial amount of current at boot- long cables or wires of too small a gauge can prevent the computer from booting.
- The external USB LCD display is used to diagnose any errors with the system. It is optional. If used, connect to USB port of flight computer.

**Note:** The external LCD can be connected and disconnected at will while the flight computer is running.
• Mount external SSD in an accessible location. Velcro is useful for mounting, as the drive is removed from the aircraft for data downloading. Connect the drive’s USB cable to any USB 3.0 port on the flight computer.

2.2.7 Installing the Downwelling Irradiance Sensor

• The optional downwelling irradiance sensor’s fiber input needs to be mounted straight-up with a clear, unobstructed view of the sky. Do not excessively bend the optical fiber. The downwelling sensor CANNOT be placed under plexiglass/polycarbonate, as it is not transparent in the NIR spectral range. Ideally, the fiber head is exposed to direct light, as even glass effects the signal.

• Connect the sensor to the flight computer via USB.

2.2.8 Connecting Power

Once all components are installed, provide power to all components of the system (Pika, flight computer, and GPS/IMU), paying close attention to min/max voltages and current requirements.

<table>
<thead>
<tr>
<th>Device</th>
<th>Voltage</th>
<th>Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pika IR</td>
<td>10.8-30V</td>
<td>10.7 W @ 12 VDC</td>
</tr>
<tr>
<td>Flight Comp.</td>
<td>12-19V</td>
<td>25W operating, 55W Peak</td>
</tr>
<tr>
<td>MicrolNS</td>
<td>9-18V</td>
<td>3W</td>
</tr>
<tr>
<td>Novatel IGM</td>
<td>10-30V</td>
<td>3W</td>
</tr>
<tr>
<td>Ellipse D</td>
<td>5-36V</td>
<td>3W</td>
</tr>
</tbody>
</table>

2.3 Installing and Connecting the Ground Station Software

The ResononGroundStation software is easily installed with the provided installer. Please uninstall older versions of the ResononGroundStation before installing newer versions, then double click the installer and follow the instructions.

2.4 Data Disk File System

Current flight computer systems format the data disk with the Windows exFAT file system. No special drivers are needed to read the data disk from a Windows computer. This applies to systems which were originally shipped with firmware version 6.0 or later.

2.4.1 Legacy System Data Disk

Systems shipped with software versions prior to 6.0 do not support the Windows exFAT file system even after upgrading firmware in the field. The external solid state drive that the data is collected on is formatted as Ext4, which Windows does not natively support. Therefore drivers are needed. There are a few options (Paragon, Ext2Explore), but the Disk Internals Linux Reader or Ext2Fsd drivers seem to be the best.

For Disk Internals:

1. Download the software at https://www.diskinternals.com/linux-reader/
2. Plug the drive into your computer and launch the software.
3. Find the drive labeled as mnt/data, and copy the desired data from there.
For **Ext2Fsd**:

1. Download the driver from [http://www.ext2fsd.com](http://www.ext2fsd.com) and install. A reboot is necessary.
2. Plug the drive into your computer and launch **Ext2Fsd**.
3. Find the drive labeled as Ext4. If no volume letter has been assigned, right click on the drive entry. Select *Change Drive Letter*.
4. Select *Add*, and then *Automatic Mount*. Select *Ok*.
5. The drive should be available in Windows for normal file transfer.

**Note:** Legacy systems which have been sent back to Resonon for upgrade may have exFAT support installed. In this case additional drivers may no longer be necessary.
3.1 Powering Up the Flight Computer

If using a laptop or external LCD to monitor the system, connect these devices to the system and then power the system on. The laptop connects to the flight computer with the supplied USB to USB null modem cable. The external LCD connects to a USB port of the flight computer.

Power up the system. The unit should remain stationary for a few minutes while the GPS/IMU acquires satellites and initializes. If the external LCD is connected to the flight computer it will display the Resonon logo while the computer is starting up. It will display system information once the flight computer software is running. Confirm that all systems are operational in the external LCD (Fig. 3.1).

It is preferred not to turn off power to the system without shutting it down with the Shutdown button on the Computer Tab of the ResononGroundStation software (Fig. 3.15).

![External LCD](image)

Fig. 3.1: External LCD
3.2 Launching the Software and Connecting to the Flight Computer

The **ResononGroundStation** software communicates with the airborne system directly through the USB to USB null modem cable.

1. Use the supplied USB to USB null modem cable to connect the laptop to the flight computer.

2. Launch the **ResononGroundStation** software. The software will automatically attempt to connect to the flight computer over the last COM port used, or COM1 on first run. If the serial port does not exist no connection is attempted.
   - If the COM port setting is not correct, simply select the correct port from the **Comms** menu item. The system attempts to connect immediately. See Fig. 3.3.
   - If the correct COM port is not available in the **Comms** menu, refresh the list by selecting **Comms → Refresh**

3. The connection dialog appears with the message *Pinging flight computer*. When the connection is established and the flight computer has transmitted it’s system status to the ground station, the dialog will display *Success* and then disappear. See Fig. 3.4.

   If the connection is not successful,
1. The system may still be starting. In this case the external LCD displays the Resonon logo. Simply wait for the system to finish starting (the LCD displays system information).

2. Press Ping Flight Computer to send a new status request to the flight computer.

3. Review your COM port settings. You must select the COM port that your computer assigned to the USB to USB null modem cable.

Fig. 3.3: COM port menu

Fig. 3.4: The ResononGroundStation Connection Dialog
3.3 Status Panel

The Status Panel (Fig. 3.5) is always visible on the left side of the main window and displays useful information regarding the status of the system.

**System Status section:**
Shows overall system status.

**Communication:**
Shows status of ground station-flight computer communications. Possible values are:

- **OK on a green background:**
  The software is in communication with the flight computer.

- **Waiting on flight computer on an orange background:**
  The ground station has not heard from the flight computer recently. This will happen if the communication cable is disconnected from the flight computer to begin a flight. Communication resumes when the cable is reconnected.

- **Error - Check software versions on a red background:**
  There has been an error processing status from the flight computer. Check the software versions reported at the bottom of the Status Panel.

**Record Status:**
Shows overall status and is mirrored on the LCD display. Possible values are:
• **Not recording on a white background:**
  The system is ready to record.

• **A target name on a green background:**
  The system is currently recording.

• **DISABLED on a red background:**
  There is a device or system error preventing recording. See *Troubleshooting* for information on procedures in this case.

*Devices section:*
shows status of the various hardware devices, to be used as quick visual confirmation that the system is operating properly. This information is mirrored on the external LCD, if it is connected. The operator should check all fields in this section at startup. See *Troubleshooting* for information on procedures if any of these sections are marked *Fail* in red.

*GPS/IMU:*
Shows the status of the GPS/IMU unit. This field is mirrored on the LCD display. See the *GPS/IMU Tab* discussion for more information.

*Imager:*
Shows imager status. This field is mirrored on the the LCD display.

*Storage:*
Shows the data disk filesystem type, free space and status. This field is mirrored on the LCD display. As an example, the field might show \[exFAT\] 539G OK on a green background to show it is using the Windows exFAT file system, has 539 GB of free disk space and is ready to record.

---

**Note:** If the field starts with \[exFAT\] the data disk may be read directly from a Windows computer. If the field starts with \[ext4\] then additional drivers will be required to read the disk on a Windows computer. See *Legacy System Data Disk* for more information.

---

See the *Storage Tab* discussion for more information.

*Downwelling:*
Shows the status of the downwelling irradiance sensor. This field is mirrored on the LCD display. The downwelling irradiance sensor is optional and the system will operate normally without it.

The *Flight Computer* section shows information about the flight computer itself.

*Name:*
A unique name assigned to the flight computer by Resonon. It is helpful to supply this name when requesting support.

*Temperature:*
The CPU temperature reported by the flight computer operating system.

The *Software* section shows the running ground station software and flight computer firmware versions. These version should be kept in sync.

*Ground Station:*
Shows the ground station software version and should be green. If the ground station and flight code versions are not compatible this field reports both the installed and the required ground station software versions on an orange background. See *Updating Firmware* in this case.

*Flight Code:*
Shows the current flight computer firmware version and should be green. If the ground station and flight computer software versions are not compatible this field is orange. See *Updating Firmware* in this case.
3.4 Flight Tab

The **Flight Tab** (Fig. 3.6) groups functions that may be useful during flight under a single tab.

**View Frame:**
Requests and displays a raw imager data frame. It is rarely used in normal operation. It can provide the operator with feedback regarding the exposure settings, but is much harder to interpret than the Histogram function.

**View Last Cube:**
Requests and displays a preview image of the last cube recorded.

**Frame Stats:**
Requests and displays the minimum pixel value, maximum pixel value, and average values for a new frame of data, intended to assist in confirming exposure settings.

**Frame Histogram:**
Requests and displays a histogram of a new imager frame. The histogram feature is likely the most useful for determining if the correct exposure settings are used. Interpreting this histogram is the same as any digital image histogram; the height of the bars show the number of pixels for each brightness level.

**Record:**
Forces the system to record a datacube. It will record continuously until the *Stop* button is pressed. This allows the operator to record data over an area outside of the defined target areas (discussed in the *Targets Tab* section).

**Stop:**
Stops manual recording.

**Record Correction Cube:**
Collects a correction cube for use with post-processing data correction. The cube collected in this step is used to remove the instrument response as well as the illumination function and leave the data in absolute reflectance.
Airborne User Manual, Release 7.3

(more info on post-processing can be found in Post Processing Data with Spectron). Before using this function, place a reflectance standard in the field of view of the imager and in a manner such that the standard is fully illuminated by the sun (no shadows). Use Auto Expose to determine the gain settings, and then record a correction cube. This cube will be in the flight's root folder and named to reflect its purpose.

**Run Auto Expose:**
Manually runs the auto exposure routine.

**Note:** Autoexpose will not run while between successive recordings inside a target area unless Preferences → Auto Expose Interval → Every Datacube is selected.

In very large target areas with Preferences → Auto Expose Interval → Outside Target Area selected, drastic changes in conditions will impact the data.
3.5 Imager Tab

The Imager Tab (Fig. 3.7) contains the settings relevant to the spectral imager. The tab title reflects the actual imager type in use by the flight computer (Pika L, Pika IR or Pika XC2).

Imager status is shown in the Status Panel as Imager (see Fig. 3.5).
**Shutter:**
Sets and displays the shutter setting of the imager in milliseconds. autoexpose will adjust the shutter upward in preference to adding gain. If there is not enough light available (as shown by the Frame Histogram button Fig. 3.6), you may need to decrease the frame rate to allow longer exposure times.

**Gain:**
This sets the gain of the imager. If autoexpose is used it is not necessary to manually change the gain settings. It should be noted that excessively high gain settings add noise to the images. autoexpose will decrease the gain in preference to decreasing the shutter setting. If autoexpose is setting the gain above zero, consider decreasing the frame rate to allow for longer exposure times.

**Note:** The Pika IR imager does not support a gain setting. When using a Pika IR, the gain control will not appear.

**Framerate:**
Sets the frame rate of the system, and with it the along-track spatial resolution. Use the Airborne HSI Calculator to determine optimum frame rate. Slower frames rates mean lower along-track spatial resolution, but better signal to noise ratios. If the autoexpose routine returns a Not Enough Light warning, or if it sets gain above zero, the framerate may be lowered to improve signal to noise ratios. Oversampling in the along track direction (using a higher frame rate than necessary for unit aspect ratio) will help compensate for flight instabilities. Depending on flight conditions such as wind and whether or not a gimbal is used, an aspect ratio of 2 or greater (as computed by the Airborne HSI calculator) is recommended.

**Cross Track Pixels:**
Displays the fixed cross-track spatial resolution of the imager.

**Bands:**
Sets the spectral resolution. Lower band numbers increase signal to noise ratios and result in smaller file sizes, but decrease spectral resolution.

**Direction:**
Sets the direction of the imager relative to the direction of flight. Set the parameter to Logo Right if the Resonon label side of the imager is facing the right (starboard) side of the plane and Logo Left is the Resonon label is facing the left (port).

**Field of View:**
Set this to the actual field of view for your imager and lens. This value will be copied into the header data for each datacube that is collected. See resonon.com for the correct value for your imager and lens.

### 3.5.1 Radiometric Calibration

As of version 4.0 Resonon’s airborne system can convert raw data to radiance in real time. A radiometric calibration file supplied by Resonon is required.

**Scan Type:**
This can be Raw data to record data with no processing, or Radiance to convert to and record radiance data on-the-fly. Without a radiometric calibration file only Raw data is available.

**Calibration File:**
The radiometric calibration file which the system will use to record radiance data.

**Load Calibration:**
Loads a radiometric calibration file from a USB thumb drive to activate the scan-to-radiance function.

**Note:** If you have more than 1 hyperspectral imager to be used with the airborne system, make sure the correct imager is connected to the flight computer when loading the calibration file. You may load separate calibration
files for e.g. a Pika L and a Pika IR imager. The flight computer will assume the calibration file is to be used by the currently connected imager type.

**Note:** Only one calibration file per imager type is allowed. If a customer swaps between two imagers of the same type (both Pika L, for instance), the correct radiometric calibration must be loaded each time the imager is swapped.

Connect a USB thumb drive with the Resonon *.icp calibration file to the flight computer. A file selection dialog pops up, as in Fig. 3.8. Select the correct calibration file and click OK. On success the dialog in Fig. 3.9 is shown and *Scan Type* is changed to *Radiance*.

![Choose a file](image)

**Fig. 3.8:** Loading a radiometric calibration file

![Info](image)

**Fig. 3.9:** Successfully loaded radiometric calibration

In the event that the error dialog in Fig. 3.10 is displayed, make sure that the USB thumb drive contains a *.icp file supplied by Resonon. Connect the thumb drive to the flight computer, not the ground station computer. Wait a few seconds to allow the flight computer to recognize the drive and try again.
Delete calibration:
Removes the calibration file for the currently attached imager type. A dialog is shown allowing you to continue or cancel. On calibration file removal Scan Type is changed to Raw data.

Saturation Correction:
This can be Set saturated values to zero to zero out saturated data before being converted to radiance (recommended as it is difficult to detect saturation after radiance conversion otherwise), or No saturation correction to record radiance data with no further processing. This setting will be unavailable if the scan type Raw data is selected.

Saturation Value (DN):
This sets the saturation value (in digital numbers) at which to zero out data; it defaults to the ceiling of the imager and can be set at any value up to this maximum. This setting will be unavailable if the scan type Raw data is selected or if the saturation correction is set to No saturation correction.

3.5.2 Auto Expose Settings
The Auto Expose Class selection fine tunes the autoexposure routine for a variety of imaging scenarios.

Normal:
The most versatile and serves as a starting point for most applications.

Darker areas of Interest:
For bright backgrounds with sparse areas of darker regions of interest (glacier background with sparse, dark pools of water of interest).

Bright Areas of Interest:
For dark backgrounds with sparse areas of bright regions of interest (desert background with sparse, bright objects of interest).

Water:
For imaging water or other scenes containing highly specular reflections (glare).

For custom settings, select the Custom item. The Handle and Target sliders will then become available. The Handle parameter determines the which percentage brightness image pixel the autoexposure algorithm will try to force to the Target percentage value. For instance, a Handle setting of 98% and a Target setting of 90% will try to force the 98th percentage brightest image pixel to 90% of the maximum brightness value. This would then allow 2 percent of the image pixels to be brighter than 90% of the maximum value and be in risk of saturation, but also allow the majority of the scene to possess good signal to noise ratios. In the case of ocean imaging where a high percentage of glint is probable, a smaller Handle setting might be preferred. These settings can be adjusted fine-tuned by utilizing the Frame Histogram feature found in the Flight Tab (Fig. 3.6).
An illustration of the Handle and Target settings is shown in figures Fig. 3.11. Assume a Handle setting of 98%, and a Target of 90%. The imager grabs a frame and analyzes it. It finds the 98th percentile brightness value to be 3300 out of a maximum 4095 (12 bit resolution = 4095 DN), as shown on the left. This is 80% of the maximum. Thus, the exposure time is increased or more gain is added and another frame is grabbed and analyzed. This process repeats until the Target value of 90% is reached, as shown on the right.

Fig. 3.11: Histogram
3.6 GPS/IMU Tab

The GPS/IMU Tab (Fig. 3.12) shows the information relevant to the GPS/IMU system and serves as a check to the proper operation of the GPS/IMU system. The tab title reflects the actual imager type in use, commonly the Ellipse. Overall GPS/IMU status is shown in the Status Panel as GPS/IMU (see Fig. 3.5). The Ellipse may show 3 different status values:

1. **OK on a green background:**
   The GPS/IMU is ready for flight, provided a proper magnetic calibration has been done. See *Ellipse GPS/IMU Magnetic Calibration* below.

   **Warning:** A proper magnetometer calibration for the Ellipse-N is mandatory. Even if the GPS/IMU status is OK the Ellipse will not track it’s position correctly without this calibration. Data loss can result! See *Ellipse GPS/IMU Magnetic Calibration* below for details.

2. **ACQUIRING GPS on an orange background:**
   This status will not change to green until the system has aligned and is able to correctly compute its position and orientation at 200 Hz.

   **Warning:** The Ellipse will not leave Acquiring GPS if the orientation of the unit is not properly configured. Configure the flight orientation in the sbgCenter software and make sure the unit is in this orientation during power up.
3. **FAIL in red:**
   The system did not find the Ellipse or was unable to initialize it. Correct the problem and restart the flight computer.

**Ground Elevation:**
The *Ground Elevation* must be set for proper operation. This is the mean sea level (MSL using EGM96 geoid) elevation of the ground. If set incorrectly, data may not be collected in the desired target regions.

**Latitude:**
The current latitude.

**Longitude:**
The current longitude.

**Alt (MSL):**
The current altitude relative to mean sea level using EGM96 geoid.

**Height (AGL):**
The current height relative to the set ground altitude.

**Show Status Detail:**
Show detailed device status in a separate window. See *Ellipse GPS/IMU Status Detail*.

**Calibrate Magnetometer:**
Begin a magnetometer calibration. See *Ellipse GPS/IMU Magnetic Calibration*.

**Current GPS Time:**
The current GPS time as reported by the GPS.

**Match System Time to GPS:**
Sets the flight computer clock to the time reported by the GPS and restarts the flight computer software. This should not normally be needed.

**Current System Time:**
The system time according to the flight computer clock. This is set to UTC time and should match the GPS time.

### 3.6.1 Ellipse GPS/IMU Status Detail

Click the *Show Status Detail* button to bring up a separate window with detailed information about the state of the GPS/IMU solution.
Pay particular attention to the *Solution Mode* at the top of the window. The software will not show the device is ready until this field reaches *Nav Position*. The meanings of each value are explained below.

- **Uninitialized**: The Kalman filter is not initialized and the returned data are all invalid.

- **Vertical Gyro**: The Kalman filter only relies on a vertical reference to compute roll and pitch angles. Heading and navigation data drift freely.

- **AHRS**: A heading reference is available, the Kalman filter provides full orientation but navigation data drift freely.

- **Nav Velocity**: The Kalman filter computes orientation and velocity. Position is freely integrated from velocity estimation.

- **Nav Position**: Nominal mode, the Kalman filter computes all parameters (attitude, velocity, position). Absolute position is provided.

### 3.6.2 Ellipse GPS/IMU Magnetic Calibration

This feature calibrates the Ellipse GPS/IMUs magnetometer after installation to compensate for any magnetic field interference.

**Warning:** A good in situ magnetometer calibration is **mandatory** for single antenna systems. If a good magnetometer calibration is not applied the GPS/IMU will not compute accurate position and attitude and can **severely** compromise the data.

**Note:** Please read the “Magnetic Calibration in Airborne Applications” document for a more detailed understanding
of the magnetometer calibration requirements.

The magnetometer calibration can be done directly on a Windows computer using the sbgCenter software, or on the flight computer using the ResononGroundStation software. This section details the second method.

If performing a 2D magnetic calibration, enter the Initial Position and Date in the sbgCenter Sensor setup tab beforehand.

![Magnetometer Calibration Window](Fig. 3.14: Ellipse Magnetometer Calibration Window)

1. To perform a calibration, first press the Calibrate Magnetometer button on the GPS/IMU Tab (Fig. 3.12). The Ellipse magnetometer calibration window appears (Fig. 3.14). Choose a 2D or 3D calibration.
   
   The 3D calibration is the most accurate. See the “Magnetic Calibration in Airborne Applications” document for a recommended set of maneuvers to perform during a 3D calibration with a manned aircraft. With a UAV it may be possible to perform a 3D calibration on the ground. Make sure the UAV is at least 10m away from any metal structure.
   
   The 2D horizontal calibration is less accurate and is best performed on the ground due to the need to keep the aircraft level. The aircraft will need to be rotated in a complete circle. Make sure the aircraft is at least 10m away from any metal structure.

2. Press the Begin button.

3. Maneuver the aircraft as appropriate for the chosen calibration type.

4. Press the Compute button to compute the calibration results.

5. If no problems are reported, press the Apply button to apply the calibration. If problems are reported, repeat this procedure.

It may be necessary to perform the magnetic calibration with the sbgCenter software if the procedure cannot be completed without errors.

Note: Once the Apply button is pressed the Ellipse will store the new calibration in non-volatile memory. The calibration does not need to be repeated on every flight unless sources of magnetic field interference are changed or the calibration is intentionally reset or overwritten.
3.7 Computer Tab

![Computer Tab Diagram]

Fig. 3.15: The Computer Tab

The Computer Tab (Fig. 3.15) contains functions cleanly shutting down and for recovering a malfunctioning system.

**Reset:**
- Resets the embedded software. This may repair a partially crashed or unresponsive system. Use this when asked to reset the flight computer, as when selecting a different imager type.

**Reboot:**
- Reboots the system. This may repair a partially crashed or unresponsive system.

**Shutdown:**
- Shuts the system down. It is best (but not necessary) to shut the system down before turning off power. Once a shutdown is executed you will need to disconnect and reapply power to the flight computer or press the flight computer power button to restart.

**Upgrade flight code:**
- Update the flight computer firmware. This should be done only on advice from Resonon. See *Updating Firmware* for details.

**Offload flight computer logs:**
- Gather flight computer logs and settings for use by Resonon to evaluate and diagnose system performance. See *Flight Computer Logs.*
3.8 Storage Tab

The Storage Tab contains functions that affect the data written to the external SSD hard disk.

The overall status of the data disk is shown on the Status Panel as Storage (see Fig. 3.5). This field may display:

- Filesystem type, disk space available and OK on a green background. The disk is ready to write data.
- Filesystem type, disk space available and LOW on an orange background. There is less than 15% disk space available for new files.
- Filesystem type, disk space available and CRITICAL on a red background. There is less than 5% disk space available for new files.
- FAIL on a red background. The disk was not found or there was an error writing to disk, possibly because the disk is full.

Note: If [exFAT] is displayed in the Storage Tab the data disk can be read by a Windows computer directly. If [ext4] is displayed additional drivers are required to read the disk from windows. See Legacy System Data Disk for more information.

View Current Files:
Shows paths and sizes of all of the folders created for data recording, one folder per datacube.

Offload Data:
This button is only used for transferring data to a external USB drive after the aircraft has landed, and is typically not used (instead, just shutdown the system and unplug the external SSD that contains the data). If using this function the external drive must be formatted as FAT32), and using a high end, high speed flash drive is encouraged.

To use, plug in the external drive and power it on. Wait 10-15 seconds for the flight computer to recognize the drive. Then press this button. A dialog is shown to walk you through the data transfer. Please do verify all data is copied to the USB drive before clearing the data disk! This method can be quite slow and is generally discouraged.

Check Disk:
Performs a data disk check on the data disk filesystem. Errors reported on an exFAT filesystem should be repaired by a Windows computer. The flight computer will attempt to repair ext4 file systems itself. A disk check should
be performed periodically, after a power loss while recording data, or if the system is reporting errors. It may also be prudent to perform after completed flights to prevent problems arising for the next flight.

**Clear Data Disk:**
Deletes all of the spectral imaging data on the system. Do not delete data until you have offloaded it to your computer!

**Reformat Data Disk:**
Completely reformats the data disk. All data will be lost. Do not reformat until you have offloaded all desired data to your computer! A message box is presented informing you that the disk format has begun. Please wait for a message dialog telling you that the format is finished, and then check that the *Data Disk* field is green and shows most of the disk space available.

### 3.9 Targets Tab

![Fig. 3.17: The Targets Tab](image)

The *Targets Tab* (Fig. 3.17) allows the operator to create, save, and upload target regions to the flight computer. These target regions define the areas over which the system will record data. When the aircraft enters a defined target area and is above the minimum height requirement, data recording is automatically started and ends when the aircraft leaves the target area. When data is recorded in a target region the name of the target region is reflected in the data folder name. Target KML files are created in *Google Earth*. Only one target file can be uploaded at a time, but each target file may define multiple target areas.
1. Use the Add → Folder option in Google Earth to create a folder. Give it an appropriate name.

2. Right click the new folder and select Add → Polygon to create a new polygon target inside the folder. The name you give the new target will be reflected in the folder names the flight computer creates for data recorded inside this target area.

3. Click points around the desired area to define a polygon (Fig. 3.18). Polygon fill colors, border widths, etc. are customizable in Google Earth and have no effect on the flight computer.

   Note: Arbitrary target shapes are supported with KML target areas. However, it is preferable to minimize the size and complexity of the individual targets. Thus, when creating polygon targets, Resonon recommends that you click individual points around the target area rather than dragging the mouse between those points. The continuous curves created by dragging are both harder for the user to draw precisely and generate much larger files.

4. Continue creating more targets in the same folder if desired.

5. Right click on the folder and select Save Place As. Use the drop down option to select KML as the format (KMZ is not supported) and save to an appropriate location on your computer. Make sure to save the folder you created, which will include all of the contained targets in the KML file.

6. Upload the KML target file using to the flight computer using the ResononGroundStation Upload KML button shown in Fig. 3.17. A file dialog will be presented allowing you to select your saved KML file.
7. Examine the Remote Targets section of the Targets Tab (Fig. 3.17). Verify each target you defined is listed under Targets found. If a target is not shown, or if a target is listed under Ignored features, something is wrong with the uploaded target file. Fix it in Google Earth and try again. Features may be ignored if they were created as paths rather than polygons, for example.

To clear these targets from the system, either upload a new KML target file or use the Clear KML button.

### 3.10 Command Line

![Command Line Tab](image)

Fig. 3.19: The Command Line Tab

The Command Line Tab (Fig. 3.19) contains an output window of messages to and from the flight computer, as well as an input window for manually sending messages to the flight computer. Please see Advanced Operation for a description.

### 3.11 Menu Items

#### 3.11.1 File

*File → About Ground Station:* Displays the version of the ResononGroundStation software.

*File → Exit:* Exits the ResononGroundStation software. This does not shut down the flight computer. Use the Computer Tab (Fig. 3.15) to do that.
3.11.2 Preferences

Preferences → Imager:
Selects the imager type in use. This is only useful if you have imagers of multiple types, or if the wrong imager is somehow selected. You will be prompted to reset the flight computer, which you can do from the Computer Tab (Fig. 3.15). If you are actually changing imagers, select Shutdown from the Computer Tab. Switch out the imager and then power up the flight computer. After the flight computer restarts the Imager Tab (Fig. 3.7) will change to reflect the new camera.

Preferences → Downwelling Irradiance:
If the system will not be using a downwelling irradiance sensor (single point spectrometer) select Disabled to prevent downwelling irradiance sensor error warnings on startup. Select Enabled to re-enable the downwelling irradiance sensor.

Preferences → Units:
Changes the ResononGroundStation software to use metric or english units. In both cases the flight computer stores values in metric units. The ResononGroundStation software converts to english units as necessary. Metric units is the preferred setting.

Preferences → Auto Exposure Interval:
Determines when the flight computer runs the image autoexpose procedure. The flight computer will not run autoexpose while it is actually recording data.

The options are:

• Outside Target Area:
The flight computer triggers autoexposure once per second when outside of target areas. Autoexposure will not run while inside any target area above the Min Height setting. This is the recommended setting.

• Every Datacube:
The flight computer will run autoexposure immediately before recording each datacube. There may be very short data holidays (gaps between successive recordings inside a target area) if the lighting changes while the unit is recording.

• Never:
The flight computer will not run autoexposure automatically. This is not recommended.

Preferences → View Output In Separate Window:
Moves the Command Line Tab to a separate window to enable viewing up/down messages and ground station controls side-by-side.

3.11.3 Comms

Comms → Refresh:
Refreshes the list of available COM ports. Click this if you connected the flight computer USB communication cable to the ground station computer after the software was started.

Comms → Ping Flight Computer:
Manually open the connection dialog Fig. 3.4 and attempt to reconnect to the ground station on the selected serial port. This is done automatically when selecting a serial port. See Launching the Software and Connecting to the Flight Computer.

Comms → Disconnect:
Close the connection to the flight computer.
Comms → COMx:
Each detected serial port is listed in the menu. Select the correct port to open a connection to the flight computer. See *Launching the Software and Connecting to the Flight Computer*.

### 3.12 Transferring Data

The fastest way to transfer data is to:

1. Shut down the flight computer
2. Unplug the SSD drive.
3. Plug the SSD drive into computer.
4. Copy data from the drive to your computer.

**Note:** Systems which originally shipped with firmware prior to 6.0 write data to a Linux ext4 file system. Use *Disk Internals* or *Ext2Fsd* to read the drive and copy data. See the section *Legacy System Data Disk* for more information.

The second alternative is to plug in an external USB drive, formatted as FAT32, to a USB port of the flight computer and press the *Offload Data* button in the *Storage Tab*. This method can be quite slow.

### 3.13 Post Processing Data with Spectronon

*Spectronon*. Resonon’s free spectral image analysis software, can be used to process airborne data from arbitrary units to radiance or reflectivity. There are a variety of *Spectronon* plugins available for each conversion.

**Radiance:**

1. With *Spectronon*, open the airborne datacube to convert.
2. Right click on the datacube to convert in the resource tree in the right hand side of the main *Spectronon* window. Select *New Cube → Correct → Radiance from Raw Data*.
3. In the resulting window, select the name of the radiometric calibration pack (’.icp’ extension), then press *OK*. The resulting cube will be in units of microflicks (1 microwatt per steradian per square centimeter of surface per micrometer of span in wavelength).

**Reflectance via downwelling data:**

Data can be converted to reflectivity using the optional downwelling irradiance sensor via the following steps.

1. Open the airborne datacube to convert.
2. Optionally, open the downwelling irradiance spectrum to be used. The plugin can also automatically use the downwelling spectrum in the airborne datacube folder for Resonon calibrated downwelling sensors.
3. Right click on the datacube to convert in the resource tree in the right hand side of the main *Spectronon* window. Select *New Cube → Correct → Reflectance from Raw Data with Downwelling Irradiance Spectrum* (or *Reflectance from Radiance Data with Downwelling Irradiance Spectrum*, depending).
4. If the downwelling sensor was radiometrically calibrated by Resonon, select *Resonon Calibrated* and the appropriate DCP calibration file in the *Downwelling Calibration* field.
5. If a third party sensor is to be used, select the units the sensor outputs in the drop down menu and the downwelling spectrum from the sensor.
6. By default, the plugin will correct for dark current using the ICP and DCP calibration files (for Resonon calibrated systems). If it is preferred to use a previously measured dark current during the correction, unselect the *Auto Remove Dark Noise* and choose the measured dark current cube or spectrum.

7. If you have a reflectance standard (such as a tarp) in a scene, you can use the data from the tarp in addition to the downwelling data to better correct the data. The creation of these correlation coefficients is described further below in this manual. Once created, you can select this correlation coefficient vector after selecting the *Use Correlation Coefficients* checkbox and then selecting the previously created correlation coefficient spectrum.

8. Press *OK*. The resulting cube will be in reflectivity on a scale of 0 to 1, 0-10,000, or 0-bit depth depending on preferences.

The downwelling sensor can be operated on the ground for short flights around a local area. This option saves weight while adding minimal complexity. To do this, collect data with the downwelling sensor using Ocean Optics software. The cosine corrector should pointing up with a clear, hemispherical view of the sky. Save the spectra, and use the *Open Spectrum* option in *Spectronon* to import the data. This spectrum can now be used in the above procedure.

**Creating correlation coefficients for use with downwelling irradiance data:**

1. Open a datacube containing the reference standard.
2. Convert this cube to reflectance using the *Reflectance from Raw Data and Downwelling Irradiance Spectrum* (or *Reflectance from Radiance Data and Downwelling Irradiance Spectrum*).
3. Use the selection tools to create a ROI of the tarp. Right-click and select *Create Correlation Coefficients*.
4. Select the file containing the measured reflectance of your standard.
5. Use this spectrum in the either of the *Reflectance from Downwelling Irradiance* plugins to better control for calibration uncertainty in the conversion process.

**Reflectance via in scene reference spectrum:**

If there is an object in the scene of measured reflectivity, it can be used to convert the data to reflectivity via the following steps.

1. Convert data to units of radiance using the *Radiance from Raw* plugin.
2. Select ROI of object of known reflectivity and create a Mean Spectrum.
3. Select *New Cube* → *Correct* → *Reflectivity from Radiance Data with Measured Reference Spectrum*.
4. Press the *Measured Reflectivity* button and select the file containing the reflectivity measurements. This file should be a tab or space delimited, with wavelength units in nanometers.
5. Press *OK*

If the reflectivity of the reference is spectrally flat over the wavelength range of interest, you do not need to use a measured reflectivity file. Instead, you can use the *Correct from Reflectivity from Radiance Data and Spectrally Flat Reference Spectrum* plugin, as follows:

1. Convert data to units of radiance using the *Radiance from Raw Data* plugin.
2. Select ROI of object of known reflectivity and create a mean spectrum.
3. Select *New Cube* → *Correct* → *Reflectivity from Radiance Data and Spectrally Flat Reference Spectrum*.
4. Enter in the reflectivity (0-1) of the reference material.
5. Press *OK*

**Export to KML:**

*Spectronon* supports exported processed spectral image cubes to KML format data.
1. Open a **georectified** datacube, as generated by Spectronon’s *Georectify Airborne Datacube* plugin.

2. Process the data using the normal analysis tools of **Spectronon**.

3. Select the resultant image and use *Export Image as KML*. Note: In order for the background pixels (the buffer areas around the spectral image data used to make the image square) transparent in the KML, they must be black in the image. You may have to use various filters (*Invert*, *Stretch*, *Threshold*, etc) in order to make the buffer pixels black before exporting to KML.

**Batch Processor:**

Spectronon’s *Batch Processor* automates the processing of multiple datacubes with a simple GUI interface. See the **Spectronon** user manual for details. If using the *Georectify Airborne Datacube* plugin with the *Batch Processor*, please note that the saved location of some of the output products (.kml,.tiff,) are designated in the plugin dialog window, and the saved location of the georectified datacube is designated in the *Batch Processor* dialog window.

---

**3.13. Post Processing Data with Spectronon**
3.14 Using the GeoRectify Spectronon Plugin

1. Launch Spectronon.
2. Open the datacube to geo-correct. If units of radiance or reflectivity are desired, these operations should be performed first as the conversion to radiance is not possible after georectification.

3. The plugin needs to know the ground elevation of the image area. This can be done using the assumption of a flat area at a known elevation (MSL using the EGM96 geoid) or by using a digital elevation map (DEM). If using a DEM file instead of a flat earth elevation, uncheck the Use Flat Earth Elev checkbox and select the DEM file to use. DEM formats supported by GDAL (www.gdal.org) are supported by this plugin. If using a flat earth elevation, enter the value in meters of the ground elevation. In general, the resolution and accuracy of freely available DEMs such as SRTM is not sufficient for low altitude flights and a flat earth elevation should be used instead. The DEM should be in MSL using the EGM96 geoid.

4. Enter the FOV of the instrument/objective lens combination. A chart is shown below.

5. Enter the desired resolution (in meters) of the end products. The Calculated Resolution numbers (cross track, along track) provide a minimum value, but typically a larger number is used to account for aircraft instabilities, etc, and avoid large amounts of interpolation.

6. By default, all output products except for the datacube will be saved in the source folder. If this is not the desired behavior, unselect the Save Products in Source Folder and select another folder. Note: When using the Batch Processor with this plugin, output products will still be saved according to this preference. Datacubes generated by this plugin follow the saving preference selected in the Batch Processor.

7. Select the desired output data products. The swath outline simply shows the outline of the imager FOV. Please note that only the full datacube will show up in the Spectronon file tree, all other products are generated and saved without any visible indication.

8. Select the desired interpolation option for both the images and datacube, if applicable. The inpaint interpolation method is the fastest. Interpolating full datacubes can be very slow.

9. If you have multiple renders of a datacube open, you can choose which render you would like to use for KML/GeoTIFF. You can also choose to apply a stretch or not. Renders are not shown by name, rather by rend0, rend1, etc, in the order they were created in. You must match up the order of the render desired by looking in the Spectronon file tree.

10. If there is a known time offset between the imager and GPS/IMU, enter the value (in seconds) in the Sync Offset field. This value is typically left at 0.

11. Enter any known angular offsets (in degrees) between the imager and GPS/IMU in the appropriate fields. Read the section below on Biases to determine sign convention.

12. If you would like to only georectify a portion of a datacube, check the Crop Cube to Start/End Lines and enter starting and ending line numbers. Care must be utilized if using this feature in the Batch Processor as cubes may have different numbers of lines.

13. Press OK.

The table below lists the FOV of Resonon imagers with different objective lenses. This information is necessary for the georectification software. It is not exact and may have to be adjusted for your particular imager.

<table>
<thead>
<tr>
<th>Focal Length(mm)</th>
<th>70</th>
<th>50</th>
<th>23</th>
<th>17</th>
<th>12</th>
<th>8</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pika L FOV(deg)</td>
<td>4.3</td>
<td>6.0</td>
<td>13.1</td>
<td>17.6</td>
<td>24.8</td>
<td>36.5</td>
<td>47.4</td>
</tr>
<tr>
<td>Pika L IFOV(mrad)</td>
<td>0.21</td>
<td>0.3</td>
<td>0.65</td>
<td>0.88</td>
<td>1.25</td>
<td>1.87</td>
<td>2.5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Focal Length(mm)</th>
<th>70</th>
<th>50</th>
<th>23</th>
<th>17</th>
<th>12</th>
<th>8</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pika XC2 FOV(deg)</td>
<td>7.7</td>
<td>10.7</td>
<td>23.1</td>
<td>30.8</td>
<td>42.7</td>
<td>60.8</td>
<td>76</td>
</tr>
<tr>
<td>Pika XC2 IFOV(mrad)</td>
<td>0.17</td>
<td>0.24</td>
<td>0.52</td>
<td>0.72</td>
<td>1.0</td>
<td>1.5</td>
<td>2.0</td>
</tr>
</tbody>
</table>
### 3.14.1 Biases

If there are angular offsets between the GPS/IMU and the spectral imager, they can be entered. These angles are measured from the GPS/IMU to the imager, following the following sign convention: Right wing up is positive roll, nose up is positive pitch, and clockwise looking down is positive yaw. The effect on the georectified image is the following: Positive roll bias shifts image to left (direction of flight is forward). Positive pitch bias shifts image back (again relative to flight direction). Positive yaw bias rotates lines counterclockwise. To determine which direction the aircraft is flying from the georectified image, use the plugin to generate a swath outline KML and open it. The green line represents the beginning of the datacube.

There is a small time offset usually needed in the Interpolation field, typically between 0 and -.05 for non-triggered systems. This offset can be determined by looking at higher frequency roll effects and determining if the GPS/IMU data is ahead or behind the image data.

To measure biases, fly the system over a fiducial landmark from multiple directions and georectify the data. Any offsets of the geocorrected images versus the fiducial are a combination of GPS error and bias. Try to eliminate the effects of GPS error by looking at the same image taken from different flight directions. Then measure the remaining offset as a distance, then convert to angle with simple geometry and knowledge of aircraft height.

### 3.15 Using the Mosaic Tool

The Mosaic Tool can be used to combine multiple georectified data sets into a single source. Due to the processing time required, and the size of the resultant file, it is recommended to only use the Mosaic Tool for GeoTiffs and not full datacubes. It should also be noted that the Mosaic Tool merges files based only on geolocation, and that no feature matching or blending is used.

1. Select File → Mosaic Tool
2. Use the Add, Add Folder, or Recursive Add Folder to select the input files.
3. Select a name and path for the output file.
4. Press OK.
OPERATION SUMMARY AND CHECKLIST

4.1 Mission Setup

1. Upload the target KML.
2. Set Framerate and Bands settings. Record test cubes to ensure the flight computer can handle the data rate.
3. Set AutoExposure Class and Interval.
4. Perform Check Disk function for routine maintenance

4.2 Pre Flight

Normal pre-flight operations are summarized below. Please see the preceding section for more details on these operations.

1. Power up system.
2. Launch ResononGroundStation software.
3. Verify all systems are operational.
4. Delete existing data.
5. Check that the system time matches GPS time. If necessary, match the system time to GPS time.
6. Set Ground Elevation if using target area Min Height setting
7. Optionally, autoexpose on a white reference and collect a correction cube.

4.3 Flight (All operations are optional)

1. Perform magnetic calibration, if necessary. This only needs to be done once as long as the plane and installation do not change. It is also not necessary for dual antennae GPS/IMUs.
2. If using a dual antenna GPS like the Ellipse D, you should fly a figure 8 or zig zag pattern to help the system lock in on heading.
3. If using an Ellipse N, allow the aircraft to exceed 15 km/h for good alignment. Data collection can happen at slower speeds.
4. Perform autoexposure, if necessary.
5. Confirm collection of datacubes while in target areas.
6. Optionally, shut down system (via Shutdown button) for return flight.

### 4.4 Post Flight

1. Shut down flight computer.
2. Remove data drive and offload data using dock/cable.
3. Convert data to radiance or absolute reflectance. Optionally classify/analyze data.
5. Classify/analyze data.

### 4.5 Data Files and Structure

The top level data folder is named by date. Inside of the data folder are folders named by target polygon name and number. Inside of these folders are the .bil, .hdr, .lcf, and .times files. A description of all data files follows.

**Per Image Files:**

- ***.bil**
  
The hyperspectral raw image data

- ***.bil.hdr**
  
The header file for the raw image data

- ***.bil.times**
  
Lists the timestamps for each frame in the HSI file. In future versions, this data may be included in the *.hdr file under the var name “line time stamps”

- ***.lcf**
  
Contains the actual location data pulled from the GPS/IMU during the cube recording.

### 4.6 Keys to Obtaining Quality Data

- Collect data under cloudless skies or uniformly cloudy conditions between 10 am and 2 pm.
- Use the largest spatial and spectral binning appropriate for the application.
- If the system is operating at non-zero gain, signal to noise ratios can be improved by slowing down the frame rate to the slowest rate appropriate for the application.
- A high quality correction cube will improve data fidelity (if using). Make sure there are no shadows or glare present when recording this cube.
- The GPS/IMU’s attitude solution is less accurate after turns. When creating a flight plan, allow the aircraft to travel straight for a short time before entering areas to be recorded. This increases the accuracy of the georectification.
- If autoexposure returns a Not Enough Light warning, the frame rate can be turned down (smaller FPS setting). This will increase the integration time of the system, allowing more light to enter. Decreasing the frame rate will decrease the along-track spatial resolution: if this is not desirable, the system can still be flown after a Not Enough Light warning, but the images may be dark and/or noisy. Alternatively, the aperture of the Pika’s objective lens can be adjusted. Please contact Resonon for consultation on this procedure.
• The use of ground tarps for reflectivity reference will always be more accurate than the use of downwelling irradiance data.

**Warning:** Adjusting the Pika’s aperture setting will void the radiometric calibration. Contact Resonon before adjusting this setting.

### 4.7 Recalibration Services

Resonon recommends a yearly schedule for wavelength and radiometric calibration for best performance, or immediately after rough handling. Please contact us for a quote and instructions.
5.1 Sending Special Commands to the Flight Computer

Many of the following sections require sending special commands to the flight computer. This is done through the `ResononGroundStation` software via serial cable. With the system running, navigate to the `Command Line Tab`. Click in the command-line box at the bottom of the window and type your command. Press <enter> to send the command to the flight computer. For example:

```
getVersion()
```

The command and any response from the flight computer command interpreter appear in the `Raw Output Window` above:

```
>>> getVersion()
<<< Revision: 7.3
```

5.2 Updating Firmware

The firmware of the spectral imaging system can be updated via USB thumb drive.

**Warning:** Updating flight computer code should only be done under the request and guidance of Resonon personnel.

1. Determine your flight computer generation from the Name setting in the ground station, as shown in Fig. 5.1, which is the number directly after ‘NUC.’

![Fig. 5.1: An example of the ground station Name setting when connected to a NUC Generation 4 flight computer](image)
2. If the flight computer generation is still unclear (or not detailed in the above setting), refer to Fig. 5.2, Fig. 5.3, and Fig. 5.4 to visually identify the flight computer’s generation.

Fig. 5.2: Current Flight Computer - NUC Generation 4 top, front

Fig. 5.3: Previous Flight Computer - NUC Generation 3 top, front

4. Resonon personnel must enable your account enabled to view and download airborne software. Please provide your account username when you contact us.

5. Download the new firmware from downloads.resonon.com. It should be found under:
   
   *Airborne → Current NUC flight computer software and documentation*
   
   Pay attention to download NUC generation 2, 3 or 4 firmware as appropriate for your system.

6. Also download the matching ResononGroundStation code (same version number as the firmware file).

7. Copy the firmware file to a USB thumb drive.

8. Before powering up the flight computer, make sure there is a free USB port. You may unplug the imager, GPS/IMU, singlepoint spectrometer or LCD display to free up a port. *Do not connect the USB thumb drive yet!*

9. Power up the flight computer and connect with the ResononGroundStation software.

10. On the advice of Resonon staff, click *Upgrade flight code* on the ResononGroundStation Computer Tab (Fig. 3.15).

11. When a dialog pops up asking for a USB drive with the desired *.enc file, attach the thumb drive to the flight computer (not the ground station computer), wait a moment and click *OK*.

12. Select the firmware file in the next dialog, and click *OK*. The *Flight Code Version* status field turns orange and says *Reboot required*. The *Ground Station Version* status field turns orange and says *Upgrade required*.

13. When prompted, remove the thumb drive and either shut down or reboot the flight computer from the Computer Tab (Fig. 3.15). A reset is not enough.

14. Close and uninstall the current ResononGroundStation program. Install the new ResononGroundStation version.

15. When the ground station version matches the flight code version, the version status fields turn green again.
5.3 Pairing a GPS/IMU with a Flight Computer

To change which type of GPS/IMU the flight computer is paired with, enter one of the following commands:

```plaintext
setImu('Ellipse')
setImu('Novatel')
```

5.4 Pairing/Unpairing a Downwelling Irradiance Sensor with a Flight Computer

If a downwelling irradiance sensor is not being used, the system will boot faster if the flight computer is instructed not to attempt to connect. For ResononGroundStation versions 4.4 and above the downwelling sensor can be disabled or re-enabled through the Preferences → Downwelling Irradiance menu.

5.5 Reformatting Disks

For system errors that can’t be repaired by Windows [exFAT filesystems] or the ResononGroundStation Check Disk function [exFAT or ext4 filesystems], it may be necessary to reformat the external hard disk. This will erase all previous data collected by the flight computer.

A data disk can be reformatted by clicking Reformat Data Disk on the Storage Tab. This can take some time for large disks.

The Reformat Data Disk button can also be used to format an additional SSD SATA data disk. The choice of SSD disk is important to system performance. Please consult Resonon for disk drive model recommendations.

5.6 Changing Default Cube Length

By default, the airborne system breaks data cubes into ~2000 lines. This value can be changed by typing setCubeSize(size) into the Commands field.

5.7 Troubleshooting

5.7.1 System Checks

- **Imager Fail:**

- **IMU Fail:**
  Cannot find GPS/IMU. Check port settings and cabling. Confirm proper GPS/IMU firmware and configuration.
• **Storage:**
  Verify the SSD disk is connected and restart. Perform *Check Disk*. If errors are reported for an exFAT filesystem, attempt a repair from Windows. The flight computer will attempt to repair ext4 filesystems itself. If this does not solve the problem, try reformatting the data disk. See the *Storage Tab* discussion for more information.

• **Downwelling Irradiance Fail:**
  Shut down the flight computer and unplug power. Check cabling. Wait 10-15 seconds and power back up.

### 5.7.2 Data problems

• **Saturated Data:**
  Use the Custom Autoexposure class and turn down the *Handle* setting from the current value.

• **Dark Data:**
  Use the *Custom* autoexposure class and turn up the *Handle* setting from the current value.

• **Noisy Data:**
  Lower the *Framerate* setting. This will decrease along-track spatial resolution. Alternatively, the aperture of the objective lens may be increased. Please contact Resonon regarding before adjusting the aperture.

• **GPS Latitude and Longitude are incorrect:**
  Reposition GPS antenna away from any potential sources of EMI. The Ellipse GPS may not show the correct position until it’s status changes from *initializing* to *OK*.

• **Poor Geo-rectification performance:**
  Have aircraft fly straight and level before entering target area, which allows the GPS/IMU to settle. Also, check GPS reception and reposition antenna if necessary.

### 5.7.3 Flight Computer Logs

When contacting Resonon with concerns about system performance, it is helpful to provide Resonon with system settings and logs. On the *Computer Tab*, click the *Offload flight computer logs* button. The dialog shown in Fig. 5.5. Attach a USB drive to the flight computer and click *begin*. After a successful download the dialog informs you that you may remove the USB drive, as in Fig. 5.6. Please provide the file called “airbornelogs.zip” to Resonon.

Fig. 5.5: The offload logs dialog
Fig. 5.6: The offload logs dialog after writing airbornelogs.zip